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偏移 
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在WINDOWS 下安装 USB驱动 

基本配置: 

1) DSO-2902(或 DSO-2904)金属铝外壳. 

2) 1个逻辑 POD盒(每个逻辑盒有 8个通道,DSO-2904有 2个 

逻辑 POD盒). 

3) 2个 HP9100探头,(DSO-2904有 4个 HP9100探头). 

4) 10根彩色线和 E-Z牌测试夹(DSO-2904是 20根) 

5) 25芯电缆一根.(如果有 USB接口则不配此电缆) 

6) USB2.0适配器一个(选件). 

7) 电源一个. 

8) DSO-2902用户手册. 

9) DSO-2902 软件光盘 CD一张. 

软件安装：(此软件需在 OFFICE系统下) 
1．运行WINDOWS软件，用WINZIP.EXE解压缩软件解压缩。 

2．运行 SETUP.EXE软件。 

3．遵循屏幕提示进行安装。 
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硬件安装：  

安装基于逻辑分析仪的并口 DSO29-XX示波器. 
1.设置并口方式为：EPP或 BPP (首选 EPP方式),在计算机启动时的
CMOS中设置。 
2.连接并口电缆一端到 DSO-2902主机盒上另一端接计算机并口。 
3.连接 12V直流电源到 DSO-2902主机盒上。 
4.等待控制软件运行。 

安装 DSO29-XX示波器 USB2.0适配器(USB2.0兼容 USB1.0版本). 

1. 关闭所有计算机以及连接外设,并关掉计算机电源. 
2. 取一个 USB2.0适配器(USB2.0适配器兼容 USB1.1版本) 
3. 连接 USB电缆到 USB接口(主机的并口). 
4. 连接 USB口另一端到 USB口适配器. 
5. 插入 12V电源适配器. 
6. 等待控制软件运行. 
7. 所有连接检测完毕,打开计算机外设,可安装软件. 

注意:并口连接只支持WIN98,USB口支持WIN2000/XP版本. 

 

操作指南 
硬件 
当用 DSO-2902数字存储示波器/逻辑分析仪进行测量时，意味着被测电路的数
据特性是事先知道的。 
在进行任何测量之前，示波器必须设定控制程序。见手册后面里的部分关于这

些步骤的介绍。 
连接数字存储示波器到测试电路, 有二个标准的 BNC探头，每个探头对应一个
模拟通道，有一个逻辑 POD盒连接在主机上，并有一系列迷你夹子连到 POD
盒上，在示波器探头一端有一个可插拔的探测夹和一鳄鱼形状的夹子接地，逻

辑分析仪 POD盒可接 8个通道（D0-D7）或 16个通道 DSO-2904（D0-D15）的
输入端，D0 通道还可用做外部时钟输入端，还有 4个接地输入端。 
数据通道可同步进行捕捉，外部时钟源连接在 D0 通道。 
有时，把测试电路同计算机系统本身连接也是必要的，这样做，将消除由于接

地电压的微小差别而导致测试应用时产生更多的噪音。特别是在高速时域分析

下，用比较粗的线连接测试电路地和计算机外壳是必要的。 
每一个模拟通道探头上都有一个效验调节螺钉，初次使用时必须效验，每年做

二次效验是必要的，见示波器效验一章。 

当用探头连接信号时，被测信号的电压必须满足 DSO29XX
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电压测量范围之内， 请查看技术指标有关绝对输入电压
值，一定要在许可范围之内。 
在探头 1：1状态下，瞬态电压：100V，连续电压：50V。 
 
逻辑分析仪 Pod盒的标记内容:  
D0-D7     是 dso2902的数据输入通道 
D0-D15   是 dso2904的数据输入通道 
GND       是连接信号地 
连线和测试夹同 POD盒构成一个模块，连线和测试夹，与 POD是可拆卸
的，测试夹可测量电路到 0.64mm,不要使测试夹超过它的使用极限，以免造
成测试夹更大的损坏。 

 

主菜单Main Screen 

 
介绍（Introduction）  

在屏幕上主要由 5个显示区构成， 屏幕左边是设置/参数显示. 中间是数据显示
区，上边是示波器模拟波形显示区，底部是逻辑分析仪波形显示区，在模拟显

示区的上面有一个微缩的“波形描述缓冲区” 它表示了游标在整个波形数据缓
冲区中所显示的位置。 
在屏幕左边沿的上边是滚动条选择区。 
在屏幕右边用户能看到所设置的模拟通道之一，用户也能用选择按钮”A1,A2”打
对勾激活通道(下一个通道名字) 
在模拟显示区的左端有一个表示对“地点”的标记，通道 A1 比通道 A2更靠近
显示，这些标记将显示与通道相同的颜色。 
在模拟显示区的左端有一个表示“触发电平设置”的标记，这些标记将显示与

触发游标相同的颜色。 
在屏幕的左下方有表示逻辑分析仪各通道的标签，这些通道在屏幕上“单击”
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就能编辑，或从[通道/设置下拉菜单]选择编辑通道名称。标签用 12个长字符表
示，在名称编辑窗口中用户也能改变通道次序。  

“单击”滚动条的选择按钮选择游标，或从视图下拉菜单中选择。 
缩小的（Thumbnail）: 
 “缩小”的图形显示区表示数据缓冲区，图形显示区表示了游标 A，游标 B，
触发游标和当前屏幕缓冲区部分数据的位置，每一项都显示它自身的颜色，如

果“缩小”功能被打开，则微缩的缓冲区波形显示在小窗口里，另外的水平线

显示表示每个通道。 
 Ground Point Tick Marks : 
 “零点”定位在模拟显示区的右边，接地点的标记为 `-|' 形状。  接地点的标记
由鼠标或通道对话框中移动。 
 触发电平标记（Trigger Level Tick Marks:） 
  定位在模拟显示区的左边，被激活的触发电平用电平 1显示，电平 2显示在右
测， 触发电平标记为 `->' 符号，所显示的触发电平和触发游标颜色一样。  
   触发电平标记由鼠标或触发对话框移动。 
逻辑分析仪二进制数据（Logic Analyzer Binary data）: 
   在逻辑显示区的左边是每个逻辑输入在游标 A和游标 B位置的二进制值。在
逻辑显示区的右边是每个逻辑输入在触发游标位置的二进制值。  
触发游标（Trigger Cursor）: 
触发游标是指在触发通道数据缓冲区内，所定义的实际触发位置的垂直游标。

(默认的颜色是红色)前后触发信息是直接同触发游标位置相关的。 
触发游标位置是由下列情况改变： 
-用鼠标拖动触发点的位置。 
-“单击”触发按钮和用水平滚动条选择触发游标。 
水平 V1条和 V2条（Horizontai V1Bar and V2Bar）: 
水平滚动条能非常容易提供测量电压的方法，选择不同通道参数显示选择，二

个游标之间的不同的电压将显示在参数显示区内。 
V1电压条和 V2电压条由下列情况移动： 
-用鼠标拖动游标的位置。 
-“单击” V1电压条和  V2电压条按钮和用水平滚动条选择游标。 
垂直游标 A和垂直游标 B（Vertical Cursor A and Cursor B）: 
 垂直滚动条提供时间测量容易的方法，选择不同通道参数显示选择，二个电压
条和触发游标之间的不同的时间显示在参数显示区内。 
游标 A和游标 B由下列情况移动： 
-用鼠标拖动游标的位置。 
-“单击”游标 A或游标 B按钮和用水平滚动条选择游标。 
-从视图下拉菜单选择触发游标。 
水平滚动条(Horizontal Scroll Bar)  
滚动条通常与选择的波形或游标有关，水平滚动条在数据显示区内左移或右移

所选择的波形或游标。  
水平滚动条同显示的模拟输入通道，逻辑分析通道，游标 A，游标 B和触发游
标有关。 
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垂直滚动条(Vertical Scroll Bar) 
滚动条通常与选择的波形或游标有关，垂直滚动条在数据显示区内上移或下移

所选择的波形或游标。  
垂直滚动条同显示的模拟输入通道，内存 V1和 V2电压指示条有关。 

Channel display选择显示的通道(A1,2,3,4 和 M1,2,3,4).  

Object point 设置游标条(V1, V2, 触发, 屏幕 (左或中心 ) ) 对缩放操作参考。 

移动一个或多个游标到显示区，这个功能也能在工具栏上“单击”实现。  

Object is cursor A周围波形显示中心区波形显示区中心在游标 A左右  。  

Object is cursor B周围波形显示中心区波形显示区中心在游标 B左右。 

Object is cursor trigger触发条周围波形显示中心区波形显示区中心在触发条左
右。  

Object is cursor A1-4 让 v1 和 v2电压指示条有一个参考对象。 

多窗口: 

该软件是革命性的软件,它有一些新的功能,甚至世界上一些著名公司的示波器都
没有这些强力功能.这个软件可以显示几个示波时序画面,让用户很容易比较和分
析波形时序,其它软件不论是台式机还是基于 PC的示波器仅能显示一幅示波时
序画面.一幅示波时序的软件仅能在同一时刻分析缓冲区的一段,不象我们的软件,
它能在同一时刻分析看到缓冲区的开始,中间,和末尾的波形.而且各自独立的示
波时序画面也支持它们自身的游标,电压测量,缩放因子等等. 

另外软件新增的功能使内存扩大 10倍,DSO-2902现在是 256K,当用户用自动功
能设置 10个时序窗口时,因为 DSO-2902能同时开 10个 256K缓冲区的时序,它
能使软件看起来有 2.56M大小,(这时计算机需要 512M以上内存),这种方法是用
软件连续捕捉数据 10次,每次都能捕捉 256K独立的缓冲区,所以用户几乎能看
2.56M内存,这个功能世界上其它任何著名的仪器都没有. 

第三个重要功能是当用户有二个显示器时,软件能显示长时间的波形,能让用户很
容易分析时序,但是台式示波器不能做到,因为台式机仅能支持一台显示器. 

第四个重要功能是在不同的显示器上支持二个不同的时序,例如:让左边的显示器
显示方波,让右边的显示器显示正弦波,这样很容易在不同的显示器上比较后来捕
捉的波形与当前捕捉的波形的不同. 但是台式示波器不能做. 

 

硬件技术指标： 
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技术指标: 
型号 DSO-2902 DSO-2902/256K DSO-2904 注释 
采样速率 1Sa/s to 250MSa/s by 1, 2, 5 次序  内时钟 

外时钟 up to 80MHz 从 D0 
通道  

记录长度 2K/8K/128K 

DSO-2902/128k 

1K/8K/128K 

DSO-2902/256k 

1K/8K/128K/256k

1K/8K/128K/256K 点 

模拟通道 A1,A2 A1,A2 A1,A2,A3,A4 2Ch / 4Ch
输入带宽 DC- 80MHz 
 输入阻抗  1Mohm//15pF 

 最大输入电压 50v (瞬态 100v ) 

@BNC  
连接  

¡@ 

 灵敏度 5mv/每格 到 2v/
每格 

10mv/每格 到 2v/每格 @探头 
1:1 

触发电平 正向或负向调节电平  垂直 10  
分区 

重复采样方式 
 支持 20ghz/
秒 

DSO-2902/128k 

     不支持 

DSO-2902/256k 

支持 20ghz/秒

支持 20ghz/秒 ¡@ 

¡@ 
数字通道 D0-D15 (16ch) D0-D7 (8ch) D0-D15 (16ch) 逻辑 Pod

   输入带宽 DC- 80MHz ¡@ 
   输入阻抗  200Kohm//4pF ¡@ 
   最大输电压  50v (瞬态 100v ) ¡@ 

门限电平 -6.35v- +6.4v -1v- +3v by 50mv 
步 

触发限定 0, 1, X (don't care) 设置对所有数字通道 ¡@ 
¡@ 

时钟技术指标： 
内部时钟 
采样速率 : 1 Sa/s 到 250 MSa/s 
时基:  4ns / 每分区  到 20000s / 每分区可显示 
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外部时钟 
频率: 1KHz--80 MHz 
外部时钟延迟: ~15ns 
 
模拟至数字斜率:  
模拟通道比逻辑通道慢 5 ns .  
设置/保持时间 :内部时钟 : 2/0 ns 相对时钟沿. 
外部时钟 : 2/0 ns 相对时钟沿. 
 
. 内存的大小显示在状态栏的右边. 
最小运行环境：控制程序软件至少需要计算机内存:  32 Mbytes RAM 
 
 
显示 
放大倍数 ： 从 1/200倍 到 1倍 到 50倍 
测试游标:：有二组游标， 游标 A 、游标 B、 V1 和 V2 ，它们是时间和电压游
标，这些游标能用垂直和水平滚动条，或用鼠标抓取来拖动，它们之间的细微

差别能自动计算和在屏幕上显示。 

效验  
探头效验: 
1) 把示波器探头的地连到示波器 BNC接头的地。 
2) 把探头的针尖对准 BNC中心小孔插进去。 
3) 这时有一个方波信号应该出现在屏幕上。 
4) 用改锥调节探头效验螺钉，直到一个很好的方波出现，而不是弧形的或有尖
峰的波形。  

 

技术指导 
电询： 
Clock Computer Corp.北京办事处 
Phone: 010-62156134 
软件升级可从我们的网址：  
http://www.vlink.com.cn 或 http://www.clock-link.com.tw  

 

二次开发库  
DSO29XXX系列能自编程控制，有 VISUAL BASIC源码库，这个软件包
（库）是一个选件，包括源程序、例子，这个软件包能有效控制 DSO29XX系
列，包括初始化、设置触发条件、设置捕捉参数、设置采样时钟和触发源、选

择增益和耦合、传送数据到 PC和保存或调出数据。 
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文件下拉菜单命令 File menu commands 

 
文件下拉菜单提供下例命令: 

调出数据（Load data）：    调完整的数据文件 (后缀为.dso), 和设置文件 (后缀
为.ini) . 
调出选择的数据（Load data option）：    调所选择的数据文件 (后缀为.dso), 靠
选择 A1,2,3,4 或 D0-D15.  

保存数据（Save data as）：选择保存数据文件 (后缀为.dso). 
调出设置（Load setting）：调出预先保存的数据设置. 
保存设置（Save setting）：保存当前设置到文件 . 

调出缺省设置（Load Default Setting）：  调出的参数设置是在工厂里预先定好
的。 

自动保存设置（Auto save settings）：控制程序软件开始运行时，能自动调出
Dsoxx.ini 设置文件，配置仪器参数。. 

保存数据到 Exacl. (Save data to Exacl). 

保存数据到文本格式 (Save data to Format). 

打印（Print）：打印数据。 
打印设置选择（Print Setup select）：输出类型及打印连接情况。 
退出（Exit）：  退出控制程序软件 。 

 

调出数据（Load data） (在文件下拉菜单 File menu) 
打开对话框，指定要打开的文件。 
文件名：  
    类型或选择用户想要打开的文件名，对话框中列出文件及扩展，用户在类型
框中选择列表文件  
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    列表文件类型: 
用户打开想要选择的文件类型： 
.INI Settings File Format 
DSO Data File Format 
驱动器： 
选择打开文件的驱动器。 
目录： 
选择打开文件的目录：  
然后敲 OK 确认或结束. 

设置文件格式 
设置文件现在用.INI格式并有说明解释内容。  

数据文件格式 
数据用二进制格式存储. 

 

文件保存 (在文件下拉菜单下 File menu) 
下例选项允许用户指定文件，和保存文件位置。 
新的文档能以不同的文件名保存，文件名含有 8个字符和 3个后缀。 用户必须
用下例专用的扩展名保存。 
保存类型如下： 
    .INI       Settings File Format 
    .DSO     Data File Format  
驱动器： 
选择保存文件的驱动器。 
目录： 
选择保存文件的目录：  
然后敲 OK 确认或结束. 

自动保存设置命令 Auto save settings command (文件下拉菜单 File 
menu) 
打开或关闭自动保存选项，打开此选项时，当程序运行时，所有设置将调出。 
打印设置命令 Print Setup command (文件下拉菜单 File menu) 
打印设置对话框配置打印机。  
退出命令 Exit command (文件下拉菜单 File menu) 
此命令结束控制程序和关闭所有命令。  

 

视图菜单命令（View menu commands）  



DSO29xx系列操作说明书 

- 11 -  

 
视图菜单有下例命令： 

color 改变全部显示颜色。 
当前颜色显示在屏幕上。 
从挑选的列表中，改变每一项颜色，用户可挑选自己喜欢的颜色。 
注意：挑选的颜色应和背景颜色不一样，否则不易观察。 

Tall parameters window 以高窗口的方式显示调节参数。 

Tall parameters window 以低窗口的方式显示调节参数 
(通常启动示波软件后把此窗口打开)。 

工具栏 Tool Bar显示或隐藏工具栏。 
状态栏 Status Bar显示或隐藏状态栏。 
网格 Grid显示或隐藏模拟显示的网格。 
时间或点 Time or Samples以时间显示或以采样点多少来显示。 

触发字 Trigger word为数字通道 D0~D7或 D0~D15设置触发字。 

 

工具栏 ToolBar (视图下拉菜单 View menu)  

 “Go”当触发条件满足时，“GO”命令使 DSO示波器开始捕捉数据。 
按下“GO”意味着开始捕捉，不按“GO”意味着停止捕捉 。  

 “Autoset”自动设置示波器参数与捕捉的信号相匹配。 

 

通道显示 Channel display (视图下拉菜单 View menu) 
当复选框是显示时，通道将显示在屏幕上。  
当复选框不显示时，通道将不显示在屏幕上， 把通道显示关闭将加速整合显
示，然而数据仍在捕捉，除非传输被关闭。  
通道显示也能在屏幕左边用按钮设置，如果通道被打开，按钮变凹。  
注意：这命令将出现在模拟和数字通道。 
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以点的方式连接 Dots connect (视图下拉菜单 View menu) 
Dots 
“单击”此选项，模拟波形的采样数据以点的方式显示，逻辑分析显示的数据

不受此选项影响。这是另一种快速显示的方法，注意： 

当用正弦或滤波方式时，是以连线的方式显示在屏幕上。 
Lines and Dots  
“单击”此选项，模拟波形的采样数据以连线和点的方式显示，逻辑分析显示

的数据不受此选项影响。这是另一种慢速显示的方法。 
注意:线和点能设置成不同的颜色。 
持续跟踪方式 Persistence mode (视图下拉菜单 View menu) 
打开或关闭持续跟踪方式，在打开方式下，每次捕捉的数据 波形都保留在屏幕
显示区，这种方式能发现偶尔产生的异常波形，也能评估信号的稳定程度。 
滚动缩放，改变显示宽度或任何的屏幕更改，将去掉老的数据，由新的跟踪数

据代替。 
从视图下拉菜单下打开持续跟踪方式，再一次从视图下拉菜单下选择关闭持续

跟踪方式。 
从视图下拉菜单下选“更新”一项，旧的数据能去掉和清除。从工具栏下敲

“更新”按钮。 
注意: 滚动缩放，改变显示宽度，或任何屏幕更新，都将去掉旧的数据。 
也可看：视图菜单，工具栏，清除按钮。 

 

时序窗口命令（Timing menu commands）  
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时钟源 Clock source选择内部或外部时钟。(在 D0 通道),  

设置上升或下降沿也就是设置内部时钟。 

Data1-10 to timing by point内存中所存储的采样点应该是捕捉数据的地方,可以
有 2 或 10 个设置不同的数据缓冲区显示数据，次序由用户确定这个功能让用户
有 128k*10 或 256k*10 的内存尺寸。  

Data1-10 to timing by auto 这同样是真的，这功能能自动捕捉 2或 10个设置数据
缓冲区，次序是：  10,9,8,7,6,5,4,3,2 ,然后是 1.  

Timing1-10<-data激活时序显示，建议用户选择多于一屏的显示得到更好的效
果。 

线 Lines 
“单击”此选项，模拟波形的采样数据点以连线的方式显示，逻辑分析显示的

数据不受此选项影响。 
点 Dots 
“单击”此选项，模拟波形的采样数据以点的方式显示，逻辑分析显示的数据

不受此选项影响。 

线与点 Lines and Dots 
“单击”此选项，模拟波形的采样数据以连线的方式和点的方式显示，逻辑分

析显示的数据不受此选项影响，这个选项显示速度慢。 
注意：线和点能设置为不同的颜色。 
滤波 Filter 
滤波器是定义如下的功能： 
 
显示数据点 Display Point data1 =(data0+2*data1+data2) /4 

持续 Persistence早先捕捉的数据残留在屏幕上，并用新的数据复盖。 
 
屏幕更新 Refresh screen 清除/更新显示 (在持续跟踪下是有用的). 

 

备份下拉菜单（Backup menu）  
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备份模拟通道 A1,2,3,4 到 M1,2,3,4 通道: 
M1= A1+ A2从当前时序窗口，存储通道 A1 用 v/div 加通道 A2 用 v/div 到 
M1( 内存 1)  

 

通道对话框 
显示通道对话框，所有通道相关参数都显示在对话框内并能很好的改变，用户

也能“单击“视图下拉菜单选择高窗口或宽窗口，使通道对话框变高或变宽。 
在对话框内选择触发通道（Trig ch）一项，选择 A1,A2,A3,A4，出现相应的通
道的参数。 

 

 
探头 Probe 
由探头输入比例控制电压衰减，输入电压应与探头比例匹配,  1：1X, 1：
10X,1：100X 或 1：1000X，当输入信号在 10V以内时，用 1：1X或 1：10V比
例都行，如果输入信号在 10V以外时，使用 1：10X探头设置在，注意用 1：
10X探头设置，当输入信号在 10V以内时，由于较小的电压通过数字转换，将
提供更好的频率响应。 

探头的电压范围和探头设置: 
10mv/每分区 到 2v/每分区 @探头设置为 1:1 
100mv/每分区 到 20v/每分区 @探头设置为 10:1 
1000mv/每分区 到  200v/每分区 @探头设置为 probe 100:1 
10v/每分区 到 2000v/每分区  @探头设置为 probe 1000:1 
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耦合方式  
有三种选择 AC, DC, 和 GND 耦合，耦合方式也能通过通道对话框改变。 
用 AC 设置, 所选择的通道用信号耦合电容耦合信号， DC成分和频率低于
10Hz的信号被滤波 ，  输入阻抗是 1MΩ，电容量是 5pF。Ω 
用 DC 设置，所有被选择的通道输入信号频率组成是允许通过的，输入阻抗是 
1MΩ，电容量是 5pF。 
用 GND 设置, 输入和 A/D是连接到地的，输入阻抗是 1MΩ，电容量是 5pF。
如果要效验示波器板，可在屏幕上设置对地参考点。  

电压/每格（Volts/Division）  
在选择模拟通道时，用每分区多少电压（V/Div）来控制信号的垂直分辨率因
数，每格多少电压（ V/Div）是按照 1-2-5 步顺序的，要得到最好的输入信号表
示法，设置每格电压时尽量在满屏上显示最大振幅，这样信号的幅值将得到最

大的信号分辨率。 
电压/每格能通过参数对话框设置。  
用探头能设置 电压/分区。 

 10mV, 20mV, 50mV, 100mV, 200mV, 500mV, 1V, 2V (1:1)  

100mV, 200mV, 500mV, 1V, 2V, 5V, 10V, 20V (10:1)  

 1V, 2V, 5V, 10V, 20V, 50V, 100V, 200V (100:1) 
 
10V, 20V, 50V, 100V, 200V, 500V, 1000V, 2000V (1000:1) 
 
偏移（Offset）  

输入信号的偏移参数同数字转换有关， 所以改变输入电压范围是可能的，如果
输入电压范围是每分区偏移+/-5V，用户用[1V/分区]  移动 1V偏差，则可用的
范围是： 6.00V 到 -4.00V，外部数据的输入范围被限幅了，并且最大值或最小
值被存储，对输入通道而言，偏移信号参考地是 0V 。 
在屏幕上接地点是有标记的，在模拟显示区的右边接地点有”勾形”标记，在对
话框中改变偏移，用滚动条的上升按钮移动，偏移也能用鼠标在模拟显示区”勾
形”标记处拖动到适当地方。  

 

频谱 FFT (窗口下拉菜单)  
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 FFT频谱窗口允许控制和显示  FFT's变换 
下面控制是可能的。  
在窗口下选择 FFT 变换窗口类型: (三角型窗, 汉宁窗, 海宁窗, 布莱克曼窗，矩形
窗 , Wetch窗 和 Parzen窗). 
采样点选择 FFT变换将采多少点，点的多少不能超过存储深度。  
选择水平和垂直缩放比率。 
FFT子程序将处理起始于光标 A处所选通道，并连续处理直到采样点数目，如
果光标 A不在显示缓冲区内，则应使用缓冲区起始点。 
瀑布谱是在屏幕上同时连续下降的 FFT变换。 
在文件保存一项中选择保存 FFT 数据。 
更多关于频谱 FFT's变换 能在下列资料中找到。 
Embedded Systems Programming magazine Volume 3, Number 5, May 1990 
Embedded Systems Programming magazine Volume 7, Number 9, Sept. 1994 
Embedded Systems Programming magazine Volume 7, Number 10, Oct. 1994 
Embedded Systems Programming magazine Volume 8, Number 1, Jan 1995 
Embedded Systems Programming magazine Volume 8, Number 2, Feb 1995 
Embedded Systems Programming magazine Volume 8, Number 5, May 1995 
Circuit Cellar Ink, The Computer Applications Journal Issue 52 Nov 1994 
Circuit Cellar Ink, The Computer Applications Journal Issue 61 Aug 1995 
Dr. Dobb's Journal Issue 227 Feb. 1995 

 

测量Measurements (窗口下拉菜单Window menu) 
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输入的波形可自动完成测量，这些包括频率、周期、上升时间、下降时间、最

大、最小、面积等等。 
完成脉冲参数测量，脉冲参数测量及分析是由显微技术实现的。 
 
有 10 个信号参数可测量测试及同步显示 ，设置测量方法可在测量下拉菜单
下： Measurements (Setup menu) 选择测试设置 (1 to 10).... 
然后选择显示测量一项，显示测量内容。 
参数测量 Parameter measurements 
 
area     面积。所有电压*采样时间之和。 
Cursor A (time) 游标 A在时间轴的位置。 
Cursor B (time) 游标 A在时间轴的位置。 

V1Bar (voltage) 电压 V1条在电压轴的位置。 
V2Bar (voltage) 电压 V2条在电压轴的位置。 
trigger cursor触发游标在时间轴的位置。 
A-B (time) 游标 A和游标 B之时间差值。 
V1-V2 (voltage) 电压 V1和电压 V2之差值。 
A-T (time) 游标 A和触发游标之时间差值。 

B-T (time) 游标 B和触发游标之时间差值。 

V_max.最大电压 
V_min.最小电压  
peak to peak峰峰值。最大和最小电压之差值。 

Average平均。平均最大和最小电压的平均。 
rms均方根值。SQRT( (1/ # samples) * ( sum ( (each voltage) * (each voltage)) )) 
rms (AC)均方根。SQRT( (1/ # 采样) * ( sum ( (each voltage - mean) * (each voltage 
- mean)) )) 
period    周期。在一定范围内所有周期中的一个周期的平均时间  
duty cycle (rising)占空比 （下降）。从中心点开始，负沿宽度同周期之比。  
duty cycle (falling)占空比 （下降）。从中心点开始，负沿宽度同周期之比。 
 risetime(10..90)上升时间（10..90）。 从 10% 到 90% 间的平均上升转换时间。  
risetime(20..80)上升时间（20..80） 。从 20% 到 80% 间的平均上升转换时间。 
falltime(10..90)下降时间（10..90） 。从 10% 到 90% 间的平均下降转换时间   
falltime(20..80)下降时间（20..80） 。从 20% 到 80% 间的平均下降转换时间。 
pulse width (positive)（脉冲宽度）（正）。  在 50%的电平下，测量正脉冲的平
均宽度。  
pulse width (negative)（脉冲宽度）（负） 。 在 50%的电平下，测量负脉冲的平
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均宽度。 
frequency （频率）。波形的平均频率. 

 

帮助菜单 Help menu 

显示网址： 

触发字 Trigger word (在设置菜单下)  

触发字能设置为 0,1,和任意,例如:00XX1100. 

从右到左,逻辑通道 0,到逻辑通道 7. 
触发字为快设置数字触发有四种限定数据。 

附件: 

USB适配器.(选件) 

测试双探头. 

动态连接库.(选件) 

设置逻辑分析仪状态窗口. 

建立状态显示. 

1. 设置组. 
2. 选择组显示,组能用不同的进制. 
3. 设置进制. 
4. 设置通道组合. 

电子记数器: 

DSO-2902有一个内置震荡器,支持高精度的电子记数
器,12500000,10000000,2000000MHZ. 

选择较大内存,它能达到 7位分辨率, 

它也能进行频率效验,相当于用户用一额外的高精度原子钟效验. 

在WINDOWS下装 USB2.0驱动见英文说明书后面. 

英文说明书 
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DSO Help Index 
How to..... 

Installing software 

Installing hardware 

Guide to operation 

Hardware Specifications 

Calibration 

Screen 

Getting started FFT 

Technical support 

Program Library 

Commands 
File menu 

View menu 

Timing menu 

Backup menu 

FFt (Window menu) 

Measurements (Window menu) 

Help menu 

¡@ 

Installing software 
1.Insert the distribution disk into drive A 
2.Run Windows. 
3.Select File menu. 
4.Select Run option. 
5.Enter file to run A:\Setup.exe 
6.Follow the on screen instructions.  

Installing hardware 
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1.Sets parallel port to Epp or Bpp Mode (prefer to Epp). 
2.Connects parallel port cable to DSO. 
3.Plug in power source from +12V Adapter. 
4.Waiting for control software turn on. 
¡@ 

 

Guide to operations 
Hardware 

When making measurements with the Digital Storage Oscilloscope / Logic 
Analyzer Cards, meaningful data can only be captured with some prior knowledge 
of the characteristics of the circuit under test. 
Before initiating any capture cycles, the DSO must be configured using the control 
program. See the software section later in the manual for instructions on these 
procedures. 
To connect the DSO to the test circuit, there are two standard BNC probes, one for 
each Analog input channel, and a series of mini-clips on the Logic Analyzer Pod 
for the Logic input channels. The scope probes have removable hook clips on their 
ends and an attached alligator clip for the signal ground connection. The Logic 
Analyzer Pod has inputs for 16 channels, D0 channel is the external clock input, 
and 4 ground points.  
For synchronous data captures, external clock sources can be connected to the D0 
channel. 
 
At times, it may also be necessary to connect the test circuit to the computer system 
itself. This will eliminate more noise in the test application due to ground level 
differentials. This is especially true when dealing with high speed timing analysis. 
Use a heavy gauge wire to make a connection between the test circuit ground and 
the case of the computer. 
Each Analog channel probe has a calibration adjustment. It is important that this 
calibration be made at least twice a year. See Calibration for more information. 
 
WHEN CONNECTING THE PROBES TO ANY SIGNAL, MAKE SURE THAT 
THE SIGNAL VOLTAGE IS WITHIN THE LIMITS OF THE DSO. CHECK 
THE TECHNICAL INFORMATION SECTION FOR ABSOLUTE MAXIMUM 
AND RECOMMENDED MAXIMUM INPUT VOLTAGES FOR THE PROBES. 
 
Logic Analyzer Pod Markings:  

D0-D7 Channel  data inputs for dso2902. 
D0-D15 Channel  data inputs for dso2904. 
GND Signal ground connection. 
 
    The wires and the clips that come with the pods are modular. The pods, wires, 
and clips can all be disconnected from each other by gently pulling them apart. 
Removing just the clips, but leaving the wires connected to the pods allows 
connections to be made to wires and posts of the test circuit of up to 0.64 mm 
(0.025 in). DO NOT INSERT WIRES OR POSTS GREATER THAN THIS 
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DIAMETER AS THAT WILL EXPAND THE CONTACTS IN THE WIRE 
BEYOND THE ALLOWED LIMIT, POSSIBLY DAMAGING THE 
CONNECTOR. 

 

Main Screen   

 
Introduction  

The main display is made up of five areas. On the left side of the screen is the 
settings/parameter display. In the middle are the data displays. The top is the analog 
waveform display. The bottom is the logic analysis digital waveform display. Above 
the analog display is a "Thumbnail" graph representing the data buffer. This also 
shows the location of the cursors and which part of the buffer is being displayed.  
 
On the upper left edge of the screen is the scroll selector area. 
 
On the right side of the screen you will see the settings for one of the analog channels. 
You can select the active channel with the "select" button (next to channel name).  
 
Just to the right of the analog waveform display are markers for the ground points. 
CH-A1 markings are closest to the display, than CH-A2. These "Tickmarks" will be 
displayed in the same color as the channel. 
 
Just to the left of the analog waveform display are markers for trigger level settings. 
These "Tickmark(s) will be displayed in the same color as the trigger cursor. 
 
The lower left section of the screen contains the channel labels for the logic analyzer. 
These can be edited on screen by clicking on them or by selected edit channel names 
from the Channel/settings menu. The labels can be any alphanumeric string up to 
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fourteen characters long. In the name edit window you can also change the order of 
the channels. 
 
To select one of the cursors for scrolling click on its selection button or select it from 
the view menu. 
 
Thumbnail: 
   The "Thumbnail" Graph display represents the data buffer. The graph shows the 
locations of Cursor A Bar, Cursor B Bar, and the Trigger cursor, and also the current 
portion of the buffer displayed on the screen. Each item is displayed in its color. If 
Thumbnails are turned on a miniature waveform is displayed, otherwise a horizontal 
line is displayed for each channel. 
    The portion of the buffer being displayed in the DSO and Logic waveform 
windows is indicated by the grid colored box . This highlight changes size and 
position depending on the zoom setting and the displayed position. 
 
Ground Point Tick Marks : 
   Located to the right of the Analog Display. The Ground Point Tick Marks are `-|' 
shaped. These display the ground points of each analog channel. Ground Point Tick 
Marks associated with Channel A1 are leftmost and Channel A2 through A4 are 
successively further to the right. They are color coded the same as the data channels 
that they refer to. 
    These Tick Marks can be moved  by grabbing and dragging with a pointing device, 
or from the Channel dialog box  
 
Trigger Level Tick Marks: 
    Located to the left of the Analog Display. The active Trigger Level(s) are displayed 
here with Level 1 displayed to the right of level 2. The Trigger Level Tick Mark is `-
>' shaped. They display the trigger levels and are color coded the same as the trigger 
cursor. 
    These tick marks can be moved  by grabbing and dragging with a pointing device, 
or by the trigger dialog box.  
 
Logic Analyzer Binary data: 
    To the left of the Logic Display are the binary values of each logic input at the 
Vertical Cursor A and Vertical Cursor B positions. To the right of the Logic Display 
are the binary values of each logic input at the Trigger Cursor position. 
 
Trigger Cursor: 
    The Trigger Cursor is a vertical cursor that defines the actual trigger position within 
the data buffer of the trigger channel. Pre and post trigger information are directly 
related to the Trigger Cursor position. 
 
The trigger cursor position can be changed by: 
-Grabbing and dragging the Trigger Cursor with a pointing device 
-Selecting the Trigger cursor by clicking on the Trigger button (in the Selection 
Buttons) and using the Horizontal Scrollbar 
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Horizontal V1Bar and V2Bar: 
    The Horizontal Cursors provide an easy means of voltage measurements. For a 
selected channel, the voltage difference between the two cursors is shown in the 
Parameters Display area. 
 
V1Bar and V2Bar can be moved by: 
-Grabbing and dragging the cursors with a pointing device 
-Selecting the Cursor by clicking on the V1Bar or V2Bar button and using the 
Vertical Scrollbar 
 
 
Vertical Cursor A and Cursor B: 
    The Vertical Cursors provide an easy means to make time measurements. For a 
selected channel, the time difference between the two VBar and the trigger cursor is 
shown in the Parameters Display area. 
 
Cursor A and Cursor B can be moved by: 
-Grabbing and dragging the cursor. 
-Selecting the Cursor by clicking on the Cursor A or Cursor B button and using the 
Horizontal Scrollbar. 
-Selecting the trigger cursor from the view menu. 
 
 
Horizontal Scroll Bar: 
    This scroll bar is used in conjunction with a selected waveform or cursor. The 
Horizontal Scroll Bar will move a selected waveform or cursor left or right in the 
display area. 
    The Horizontal Scroll Bar works with Display, Analog input channels, Memory, 
Logic Analyzer channels, Cursor A, Cursor B, and Trigger Cursor. 
 
Vertical Scroll Bar: 
    This scroll bar is used in conjunction with a selected waveform or cursor. The 
Vertical Scroll Bar will move a selected waveform or cursor up or down in the display 
area. 
    The Vertical Scroll Bar works with Display, Analog input channels, Memory, 
V1Bar, and V2Bar.  

¡@  

Channel display     Select  display Channel(A1,2,3,4 and M1,2,3,4).  

Object point  

  Set cursor Bar(V1, V2, Trigger, Screen (left or center) ) for zoom operate reference.  

Moves one or more cursors to the display area. These commands are also available by 
clicking on the toolbar.  
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Object is cursor A  Centers waveform display area around Cursor A.  

Object is cursor B Centers waveform display area around Cursor B.  

Object is cursor trigger  Centers waveform display area around the Trigger Bar.  

Object is cursor A1-4  Let v1 and v2 have reference object.  

¡@ 

¡@  

 

Hardware Specifications  

Specifications:  

Model DSO-2500 
DSO-2902/128k 

DSO-2902/256k 
DSO-2904 Remark 

Sampling Rate 1Sa/s to 250MSa/s by 1, 2, 5 sequence Internal 
clock 

External clock up to 80MHz 
From 
Channel 
D0 

Record Length 2K/8K/128K 

DSO-2902/128k 

1K/8K/128K 

DSO-2902/256k 

1K/8K/128K/256k

1K/8K/128K/256K Point 

Analog Channel A1,A2 A1,A2 A1,A2,A3,A4 2Ch / 
4Ch 

  Input 
Bandwidth DC- 80MHz 

  Input 
Impedance 1Mohm//15pF 

  Max. input 
voltage 50v (100v Transient) 

@BNC 
connect 

¡@ 

  Sensitivity 5mv/div to 
2v/div 10mv/div to 2v/div @Probe 

1:1 

Trigger Level Positive or Negative Slope adjustable level   10 
Vertical 



DSO29xx系列操作说明书 

- 25 -  

Divisions

Repetitive Mode Support to 
20ghz 

DSO-2902/128k 

no Support 

DSO-2902/256k 

Support to 20ghz 

Support to 20ghz ¡@ 

¡@ 

Digital Channel D0-D15 (16ch) D0-D7 (8ch) D0-D15 (16ch) Logic 
Pod 

  Input 
Bandwidth DC- 80MHz ¡@ 

  Input 
Impedance 200Kohm//4pF ¡@ 

  Max. input 
voltage 50v (100v Transient) ¡@ 

Threshold 
Voltage -6.35v- +6.4v -1v- +3v by 50mv 

step 
Trigger Qualify 0, 1, X (don't care) settings for all Digital channels ¡@ 
¡@ 

Clock specification: 
Internal 
Sampling Rate : 1 Sa/s to 250 MSa/s 
Time base:  4ns / Division to 20000s / Division displayable 
 
External 
Frequency : up to 80 MHz 
External Clock Delay: ~15ns 
 
Analog to Digital skew: 

Analog channels  are 5ns slower than Logic channels.  
Setup/Hold Time : Internal Clock: 2/0 ns relative to clock edge. 
External Clock: 2/0 ns relative to clock edge. 
 
The memory mode will be displayed on the right side of the status bar. 
Minimum required: a minimum of 128 Mbytes RAM is necessary to use the DSO 
control program. 

256 Mbytes system RAM  will be better. 
 
DISPLAY 
Magnification : from 1/200X to 1X to 50X 
Cursors: There are two cursors. Cursor-A  Cursor-B,V1 and V2 they are  time and 
voltage cursor1. They can be moved using the horizontal and vertical scroll bars or by 
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grabbing and dragging them. Differences are automatically calculated and displayed 
on the screen. 

 

Technical Support  
 
Please call  
Clock Computer Corp. 
Phone: 886-2-29340273 
 
Software can also be downloaded from our website 
http://www.clock-link.com.tw  

 

Programming Library  
 
The VISUAL BASIC  programming library is a source code level set of procedures 
that allow full control of the DSO-xxxx  from your own programs. This is an optional 
package that is available from Clock Computer. 
 
The package includes the source files for the library, example code for using the 
library. 
 
The library consists of subroutines for full control of the DSO-xxxx. This includes 
routines to initialize the board, setup trigger conditions, setup acquisition parameters 
like sample clock rate and source, choose the gain and coupling settings, transfer data 
from the board to the PC, and save and load data to files. 
 

 

File menu commands 

 
The File menu offers the following: 
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Load data    This option loads a full data file (.dso), with a setting file (.ini) together. 
Load data option    This option loads a data file (.dso), depend on the select of 
A1,2,3,4 or D0-D15.  

Save data as   This option saves a data file (.dso). 
Load setting    This option loads a previously `Save setting' setups. 
Save setting    This option saves the current settings to a file. 

Load Default Setting  Load default.ini to load  parameters to factory defaults. 

Auto save settings    Auto load Dsoxx.ini setting file on program start run to set all 
configuration. 
 
Print    This option allows you to print the data.  
 
Print Setup select    output style, printer and printer connection. 
Exit    Exit DSO  software 

 

Load data (File menu) 
 
Specify which file to open in the file open dialog box: 
 
File Name:  
    Type or select the filename you want to open. This box lists files with the extension 
you select in the List Files of Type box.  
    List Files of Type: 
Select the type of file you want to open: 
    .INI       Settings File Format 
    .DSO    Data File Format  
Drives 
    Select the drive in which to retrieve the file that you want to open.  
Directories 
    Select the directory in which to retrieve the file that you want to open. 
 
Click on OK when done, or Cancel to abort.  

 
Settings File Format 
 
The settings are now saved in an .INI file format and should be self explanatory.¡@  

Data File Format 
 
 
data stored  in binary format.  
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File Save (File menu) 
 
The following options allow you to specify the name and location of the file you're 
about to save: 
 
Type a new filename to save a document with a different name. A filename can 
contain up to eight characters and an extension of up to three characters. You must 
use one of the listed extensions to specify the type of file you wish to save. 
Save File as Type 
 
    .INI       Settings File Format 
    .DSO     Data File Format  
    
 
Drives 
Select the drive in which you want to save the file. 
Directories 
Select the directory in which you want to save the file. 
 
Click on the OK button when done, or Cancel to abort. 

¡@  

Auto save settings command (File menu) 
 
Turns on or turns off the Autosave  option. When this option is on, all settings will be 
loaded when start the program. 
 
 
Print Setup command (File menu) 
 
 
 Print Setup dialog box allows you to configure the printer. 
 
Exit command (File menu) 
 
Use this command to end your session. You can also use the Close command on the 
application Control menu.   

 

View menu commands  
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The View menu offers the following:  

color     Change colors of the entire display. 
               The current colors are displayed on screen. 
                To change the color of an item select it from the pick list. Then use the 
color palate to pick a new      color. 
 
Note: Items that are the same color as the background will not be visible. 
Tall parameters window  Show parameter in tall way   

Tall parameters window Show parameter in wide way   

Tool Bar     Show or hide Tool Bar. 
Status Bar     Show or hide Status Bar. 
Grid     Show or hide grid on analog display. 
Time or Samples     For Timing display, display Time like as 12.34ms, or display how 
many samples.  

Trigger word    Set Trigger word for digital channel D0-D15.  

 

ToolBar (View menu)  

  The Go command tells the DSO  to start acquiring data when the trigger 
conditions are satisfied.  
        Pressed means Start capture, unpressed means stop capture.  

   Automatic setup parameters for capture.  

 

Channel display (View menu) 
 
When Display is checked, the channel will be displayed on the screen. 
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When Display is not checked, the channel will not be displayed on the screen. 
Turning Display off for a channel will both speed up and unclutter the display. 
However the data is still acquired from that channel unless transfer is turned off. 
 
A channel's display can also be set with the buttons on the left edge of the screen. If 
the channel is on the button will be highlighted. 
 
 
 
Note: This command applies to both analog and digital channels. 

 

Dots connect (View menu) 
 
Dots  
Checking this option will display only the data points of the analog waveform. Logic 
data is unaffected by this option. This is the second fastest display option. Note that 
Lines will always be shown when in Sin (X)/X or Filter Interpolation modes. 
 
Lines and Dots  
Checking this option will display the lines connecting the data points and the data 
points of the analog waveform. Logic data is unaffected by this option. This is the 
slowest display option. 
 
Note: The lines and dots can be set to different colors. 
 
 
Persistence mode (View menu) 
 
Turns on or turns off Persistence Mode. In this mode, with each acquisition of data, 
all previous waveform data remains on the display area. This mode is useful for 
finding waveform anomalies that occur infrequently. Persistence Mode is also useful 
for evaluating signal jitter. 
 
Scroll, zoom, change display width, or any update of the screen will erase all of the 
old data and will initiate a new Persistence Mode capture. 
 
To turn Persistence On, select Persistence from the View Menu. To turn Persistence 
Off, select Persistence again from the View Menu. 
 
All old data can be cleared, or erased from the display by selecting Refresh screen 
from the View menu,  by clicking on the `refresh' button from the toolbar 
 
Note: scroll, zoom, change display width, or any update of the screen will erase all of 
the old data. 
 
See also: View menu, Toolbar, clear button 
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Timing menu commands  

 

 Clock source    Select internal clock or external clock(D0 channel),  

                         set rising or falling edge id set external clock.  

Data1-10 to timing by point  User point which timing memory should be placed for 
captured data ,it can  

                                            let user captured  2 or 10 set different data to buffer and 
display , the sequence         pointed by user, this function let user have 128k*10 or 
256k*10 memory size.  

Data1-10 to timing by auto The same is true for it, it automatically capture 2 or 10 
sets data to buffer , the sequence is 10,9,8,7,6,5,4,3,2 then 1.  

Timing1-10<-data   Activate timing display. we suggest user  use more than 1 screen 
to get better show.  

 
Lines 
Checking this option will display only the lines connecting the data points of the 
analog waveform. Logic data is unaffected by this option.  
Dots 
 
Checking this option will display only the data points of the analog waveform. Logic 
data is unaffected by this option.  
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Lines and Dots 
 
 
Checking this option will display the lines connecting the data points and the data 
points of the analog waveform. Logic data is unaffected by this option. This is the 
slowest display option. 
 
 
Note: The lines and dots can be set to different colors. 
 
Filter 
 
Filter is an averaging function and is defined as: 
 
Display Point data1 =(data0+2*data1+data2) /4 

¡@  

Persistence    Data from previous captures remains on screen and is overlaid by new 
data. 
 
Refresh screen  Clear/refresh the display (useful in persistence mode). 

¡@  

¡@  

 

Backup menu  

 

¡@  

Backup Analog Channel A1,2,3,4 to M1,2,3,4 channel: 
M1= A1 to A2    Store channel A1 with v/div plus channel A2 with v/div to 
M1( memory 1) for current timing view. 
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Channel Dialog Box 
 
Show the Channel Dialog Box. All channel parameters are displayed in this box and 
can be altered in it as well. You can bring up this dialog by clicking on the "view 
menu" ,select tall or wide window 
 
A different channel can be selected by hitting the "A1,A2,A3,A4" Ch Select button. 

 

 
 
Probe  
This controls the attenuation level for the probe inputs. This should be set to match 
the probe itself, either 1X, 10X,100X or 1000X. When working with signal 
amplitudes within ?0 V, either the 1X or the 10X setting can be used. However, if the 
signal amplitude is outside of ?0 V, use the 10X setting. Note that using the 10X 
setting with both the probe and the scope even for signals within ?0 V will provide 
better frequency response through the system due to smaller voltage swings through 
to the digitizer..  
 
Voltage range Probe and probe settings: 
 
10mv/div to 2v/div @probe 1:1 
100mv/div to 20v/div @probe 10:1 
1000mv/div to 200v/div @probe 100:1 
10v/div to 2000v/div @probe 1000:1 

Coupling  
The three selections available are AC, DC, and GND couple. Coupling can also be 
changed by Channel dialog box. 
In the AC setting, the signal for the selected channel is coupled capacitively, 
effectively blocking the DC components of the input signal and filtering out 
frequencies below 10 Hz. The input impedance is 1MW || 5pF. 
In the DC setting, all signal frequency components of the signal for the selected 
channel, are allowed to pass through. The input impedance is 1 MW || 5pF. 
In the GND setting, both the input and the A/D converter are connected to ground. 
Again, the input impedance is 1 MW || 5pF. Use for setting the Ground reference 
point on the display or if calibrating the DSO board.  

Volts/Division  
V/Div controls the vertical sensitivity factor in Volts/Division for the selected analog 
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channel. Each V/Div step follows in a 1-2-5 sequence. To get the best representation 
of the input signal, set V/Div such that the maximum amplitude swing is displayed on 
the screen. This will match the signal amplitude to use most of the digitizer's range, 
allowing the most bits to be used. 
Volts/division can be set via the V/div Combo to Settings. 
 
Volts/Division Probe can be set to   

 10mV, 20mV, 50mV, 100mV, 200mV, 500mV, 1V, 2V (1:1)  

100mV, 200mV, 500mV, 1V, 2V, 5V, 10V, 20V (10:1)  

 1V, 2V, 5V, 10V, 20V, 50V, 100V, 200V (100:1) 
 
10V, 20V, 50V, 100V, 200V, 500V, 1000V, 2000V (1000:1) 
 
Offset  

This parameter offsets the input signal in relation to the digitizer. This changes the 
usable input voltage range. The input voltage range is the offset +/- 5 divisions. Thus 
if you moved the offset to 1.00V with 1V /division the usable range would be 6.00V 
to -4.00V. Data outside the input range is clipped and stored as either the max or min 
input value. The offset references the 0.00V point (GND) for the input channel.  
 
The ground point is marked on the screen by the Ground Point Tick Marks to the right 
of the Analog Display. To change the offset in this dialog box, move the elevator 
button in the scroll bar. The offset can also be changed by  grabbing and moving the 
appropriate Ground Point Tick Mark in the analog display area.   

 

FFT (Window menu)  
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The FFT window allows control and display of FFT's. 
 
The following controls are available:  
 
Window Select the FFT window type: (Triangular, Hanning, Hamming, Blackman-
Harris, Rectangular, Wetch and Parzen). 
Sample points Select how many points the FFT will sample,  points can't exceed 
memory depth. 
Horizontal zoom Select horizontal zoom ratio. 
 
The FFT routines will process the selected channel starting at Cursor A and continue 
until "Sample Points" number of points has been reached. If Cursor A is not within 
the buffer, start of buffer will be used.  
 
Waterfall display shows successive FFT breakdowns simultaneously on the screen 
offset from each other. This creates a waveform that shows the frequency behavior 
overtime. Up to 10 FFT breakdowns are shown at one time with the oldest furthest 
back. Typical uses include impulse response decay time in audio work. 
 
To save FFT data go to File Save and choose a file type of "FFT". 
 
Further information on FFT's can be found in the following sources: 
Embedded Systems Programming magazine Volume 3, Number 5, May 1990 
Embedded Systems Programming magazine Volume 7, Number 9, Sept. 1994 
Embedded Systems Programming magazine Volume 7, Number 10, Oct. 1994 
Embedded Systems Programming magazine Volume 8, Number 1, Jan 1995 
Embedded Systems Programming magazine Volume 8, Number 2, Feb 1995 
Embedded Systems Programming magazine Volume 8, Number 5, May 1995 
Circuit Cellar Ink, The Computer Applications Journal Issue 52 Nov 1994 
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Circuit Cellar Ink, The Computer Applications Journal Issue 61 Aug 1995 
Dr. Dobb's Journal Issue 227 Feb. 1995 

 

Measurements (Window menu) 

 
 
Automatic measurements on input waveforms can be performed. These include 
frequency, period, rise time, fall time, min, max, area, ....  
Pulse parameter measurements are performed as specified by ANSI/IEEE std 181-
1977 IEEE Standard on Pulse Measurement and Analysis by Objective Techniques. 
 
Up to 10 signal parameters can be measured, tested, and displayed simultaneously. To 
setup a measurement, select the Measurements (Setup menu) and choose one of the 
tests to setup (1 to 10).... 
 
Parameter measurements 
 
area     Sum of all voltages * sample time. 
Cursor A (time) Position of Cursor A in time. 
Cursor B (time) Position of Cursor B in time. 

V1Bar (voltage) Position of V1Bar in voltage. 
V2Bar (voltage) Position of V2Bar in voltage. 
trigger cursor Position of trigger cursor in time. 
A-B (time) Time difference between Cursor A and Cursor B. 
V1-V2 (voltage) Voltage difference between V1Bar and V2Bar. 
A-T (time) Time difference between Cursor A and trigger cursor. 
B-T (time) Time difference between Cursor B and trigger cursor. 

V_max.     Maximum voltage. 
V_min.     Minimum voltage. 
peak to peak     The difference between maximum and minimum voltages.  

Average     Average of minimum and maximum voltages. 
rms SQRT( (1/ # samples) * ( sum ( (each voltage) * (each voltage)) )) 
rms (AC)     SQRT( (1/ # samples) * ( sum ( (each voltage - mean) * (each voltage - 
mean)) )) 
period     Average time for a full cycle for all full cycles in range. 
duty cycle (rising)     A ratio of width (rising) to period. starting with a positive edge 
using midpoint. 
duty cycle (falling)     A ratio of width (falling) to period. starting with a negative 
edge using midpoint.  
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risetime(10..90)     Average time for a rising transition between the 10% to the 90% 
points 
risetime(20..80)     Average time for a rising transition between the 20% to the 80% 
points. 
falltime(10..90)     Average time for a falling transition between the 10% to the 90% 
points 
falltime(20..80)     Average time for a falling transition between the 20% to the 80% 
points. 
pulse width (positive)     Average width of positive pulses measured at 50% level. 
pulse width (negative)     Average width of negative pulses measured at 50% level. 
frequency     Average frequency of waveform. 

 

  

Help menu 

¡@show our web site 

Trigger word (Setup menu)  

 
 
The Trigger word backup four Qualify data for quickly set digital trigger.  

Calibration   

 
Probe calibration: 
1) Connect the scope probe Ground Connection to the BNC GND. 
2) Hold the probe's tip against the calibration point on the BNC center Hole. 
3) A Square wave signal should appear on the screen. 
4) Adjust the probe calibration until a true square wave is shown on the screen, noting 
the corners of the waveform which should be sharp and square, not rounded over or 
peaky.  

 

 


